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I.1 STARTING MATLAB, MATLAB WINDOWS

It 1s assumed that the software 1s installed on the computer, and that the user can
start the program. Once the program starts, the MATLAB desktop window opens
(Figure 1-1). The window contains four smaller windows: the Command Window,
the Current Folder Window, the Workspace Window, and the Command History
Window. This 1s the default view that shows four of the various windows of MAT-
LAB. A list of several windows and their purpose 1s given in Table 1-1. The Start
button on the lower left side can be used to access MATLARB tools and features.

Four of the windows—the Command Window, the Figure Window, the Editor
Window, and the Help Window—are used extensively throughout the book and
are briefly described on the following pages. More detailed descriptions are
included in the chapters where they are used. The Command History Window,
Current Folder Window, and the Workspace Window are described in Sections
1.2, 1.8.4, and 4.1, respectively.

Command Window: The Command Window i1s MATLAB’s main window and
opens when MATLARB 1s started. It 1s convenient to have the Command Window
as the only visible window, and this can be done by either closing all the other
windows (click on the x at the top right-hand side of the window you want to
close) or by first selecting the Desktop Layout in the Desktop menu, and then



When typed, these words appear in blue. An error message is displayed if the user
tries to use a keyword as a variable name. (The keywords can be displayed by typ-
ing the command iskeyword.)

A number of frequently used variables are already defined when MATLAB i1s
started. Some of the predefined variables are:

ans A variable that has the value of the last expression that was not assigned to a
specific variable (see Tutorial 1-1). If the user does not assign the value of
an expression to a variable, MATLAB automatically stores the result in
ans.

pi  The number m.

eps The smallest difference between two numbers. Equal to 2°(—52), which 1s
approximately 2.2204e—016.

inf Used for infinity.

i Defined as /=1 . which is: 0 + 1.0000i.
] Same as 1.

NaN Stands for Not-a-Number. Used when MATLAB cannot determine a vahd
numeric value. Example: 0/0.

The predefined variables can be redefined to have any other value. The vari-
ables pi, eps, and inf, are usually not redefined since they are frequently used
in many applications. Other predefined variables, such as i and j, are sometime
redefined (commonly in association with loops) when complex numbers are not
involved in the application.

1.7 USEFUL COMMANDS FOR MANAGING VARIABLES

The following are commands that can be used to eliminate variables or to obtain
information about variables that have been created. When these commands are
typed in the Command Window and the Enter key is pressed, either they provide
information, or they perform a task as specified below.

Command Qutcome

clear Removes all variables from the memory.

clear x y z Removes only variables x, v, and z from the
memory.

who Displays a list of the variables currently in the
memory.

whos Displays a list of the variables currently in the

memory and their sizes together with informa-
tion about their bytes and class (see Section 4.1).



« A variable that already exists can be reassigned a new value. For example:

>> ABB=72; [ A value of 72 is assigned to the variable ABB. ]
>> ABB=9; | A new value of 9 is assigned to the variable ABB. |
>> ABB : ,
Fom \ The current value of the variable is dis-

9 played when the name of the variable is
s> . typed and the Enter key 1s pressed.

* Once a variable 1s defined it can be used as an argument in functions. For exam-
ple:

>>» x=0.75;

»>> E=sin(x) "2+cos (x) "2
E =

1
>

1.6.2 Rules About Variable Names

A variable can be named according to the following rules:
* Must begin with a letter.

 (Can be up to 63 characters long.
* (Can contain letters, digits, and the underscore character.
« (Cannot contain punctuation characters (e.g., period, comma, semicolon).

« MATLARB is case sensitive: it distinguishes between uppercase and lowercase let-
ters. For example, AR, Aa, a2, and aa are the names of four different variables.

» No spaces are allowed between characters (use the underscore where a space 1s
desired).

* Avoid using the name of a built-in function for a vanable (1.e., avoid using cos,
sin, exp, sgrt, etc.). Once a function name 1s used to define a variable, the
function cannot be used.

1.6.3 Predefined Variables and Keywords

There are 20 words, called keywords, that are reserved by MATLAB for various
purposes and cannot be used as variable names. These words are:

break case catch classdef continue else elseaf
end for function global if otherwise parfor
persistent return spmd switch try while



The last statement (x = 3x - 12) illustrates the difference between the assignment
operator and the equal sign. If in this statement the = sign meant equal, the value
of x would be 6 (solving the equation for x).

The use of previously defined variables to define a new vanable 1s demon-
strated next.

>> a=12 | Assign12toa. |
A=

12
>> B=4 | Assign4toB. |
B =

4 3 .

>> C=(a-B)+40-a/B*10 .ﬂ'—"l_l.ssign the vglue of the expres-
T sion on the right-hand side to

18 the vanable C.

» [f a semicolon 1s typed at the end of the command, then when the Enter key is
pressed, MATLAB does not display the vanable with its assigned value (the van-
able still exists and is stored in memory).

» [fa vanable already exists, typing the variable’s name and pressing the Enter key
will display the variable and its value in the next two lines.

As an example, the last demonstration 1s repeated below using semicolons.

>> a=12; The variables a, B, and C are defined
>> B=4; but are not displayed since a semicolon
>> C=(a-B) +‘n_.ia*1n; ] i.S t}'p-ed at thE E“d Df Ea{:h statement.

>> C ~
c = The value of the vanable C 1s displayed
18 by typing the name of the variable.

» Several assignments can be typed in the same line. The assignments must be sepa-
rated with a comma (spaces can be added after the comma). When the Enter key
1s pressed, the assignments are executed from left to nght and the vanables and
their assignments are displayed. A vanable 1s not displayed if a semicolon 1s typed
instead of a comma. For example, the assignments of the vanables a, B, and C
above can all be done in the same line.

>> a=12, B=4; C=(a-B)+40-a/B*10

12 The vanable B is not displayed because a semi-

e colon 1s typed at the end of the assignment.

18




Table 1-5: Rounding functions (Continued)

Function Description Example
sign(x) Signum function. Returns 1 1f >> sign(5)
x>0,-11fx<0,and 0 1f ans =
x =0, 1

1.6 DEFINING SCALAR VARIABLES

A vanable 1s a name made of a letter or a combination of several letters (and dig-
its) that 1s assigned a numerical value. Once a vanable 1s assigned a numerical
value, 1t can be used 1n mathematical expressions, in functions, and in any MAT-
LAB statements and commands. A variable 1s actually a name of a memory loca-
tion. When a new vaniable 1s defined, MATLARB allocates an appropriate memory
space where the variable’s assignment 1s stored. When the vanable 15 used the
stored data 1s used. If the vanable 1s assigned a new value the content of the
memory location 1s replaced. (In Chapter 1 we consider only vanables that are
assigned numerical values that are scalars. Assigning and addressing variables
that are arrays 1s discussed in Chapter 2.)

1.6.1 The Assignment Operator

In MATLAB the = sign 1s called the assignment operator. The assignment opera-
tor assigns a value to a vanable.

Variable name = A numerical value, or a computable expression

* The left-hand side of the assignment operator can include only one variable name.
The night-hand side can be a number, or a computable expression that can include
numbers and/or variables that were previously assigned numerical values. When
the Enter key 1s pressed the numerical value of the right-hand side 1s assigned to
the vaniable, and MATLAB displays the varnable and its assigned value 1n the next
two lines.

The following shows how the assignment operator works.

>> x=15 | The number 15 is assigned to the variable x. |

. MATLAB displays the vanable
Lo and 1its assigned value.

>> x=3%x-12 - : : :
A new value 1s assigned to x. The

new value 1s 3 times the previous
value of x minus 12

X =

33

>>




Table 1-3: Elementary math functions (Continued)

Function Description Example
factorial (x) The factonal function x! >> factorial (5)
(x must be a positive integer.) — :n
1

Table 1-4: Trigonometric math functions

Function Description Example
sin (x) Sine of angle x (x 1n radians). >> sin(pi/6)
sind (x Sine of angle x (x 1n degrees). o

(%) gle x ( grees) . Each
cos (x) Cosine of angle x (x in radians). >> cosd(30)
cosd (x) Cosine of angle x (x in degrees). T

0.8660

tan (x) Tangent of angle x (x in radians). >> tan(pi/6)
tand (x Tangent of angle x (x in degrees). ans =

(%) g glex( grees) HEES
cot (x) Cotangent of angle x (x in radians). | >> cotd(30)
cotd (x) Cotangent of angle x (x in degrees). | *°% : -

The mverse trigonometric functions are asin(x), acos (x), atan (x),
acot (x) for the angle in radians; and asind (x), acosd (x), atand (x),
acotd (x) for the angle in degrees. The hyperbolic trigonometric functions are
sinh (x), cosh(x), tanh(x), and coth (x) . Table 1-4 uses pi, which 1s
equal to m (see Section 1.6.3).

Table 1-5: Rounding functions

Function Description Example
round (x) Round to the nearest integer. >> round(17/5)
ans =
3
fix (x) Round toward zero. >> £ix(13/5)
ans =
2
ceil (x) Round toward infinity. >> ceil(11/5)
ans =
3
floor (x) Round toward minus infinity. >> floor(-9/4)
ans =
=
rem(x,Vy) Returns the remainder after x1s | >> rem(13,5)
divided by y. o =3




of using the function sgrt (x) when MATLAB 1s used as a calculator with sca-
lars.

Tutorial 1-2: Using the sgrt built-in function.

>> sqrt(64) [ Argument 1s a number. ]
ans =

8
>> sqrt(50+14*3) [ Argument is an expression. |
ans =

9.5917
>> sqgrt(54+9*sqgrt (100)) [ Argument includes a function. J
ans =

12
>> (15+600/4) /sqrt(121) f Function 1s included 1n an expression. ]
ans =

15
>>

Some commonly used elementary MATLAB mathematical built-in functions
are given in Tables 1-3 through 1-5. A complete list of functions organized by cat-
egory can be found in the Help Window.

Table 1-3: Elementary math functions

Function Description Example
sgrt (x) Square root. >> sqrt(81)
ans =
B
nthroot (x,n) Real nth root of a real number x. | >> nthroot(80,5)
(If x 1s negative n must be an | @8R8 =
odd integer.) 2o
exp (x) Exponential (e¥). >> exp(3)
ans =
148.4132
abs (x) Absolute value. >> abs (-24)
ans =
24
log (x) Natural logarithm. >> log(1000)
Base e logarithm (In). by =
6.9078
1ogl0 (x) Base 10 loganthm. >> logl0(1000)
als =

3.0000




Table 1-2: Display formats

Command Description Example

format short Fixed-point with 4 decimal |>> 290/7
digits for: .
0.001 < number < 1000 LSS
Otherwise display format
short e.

format long Fixed-point with 15 decimal |>> 290/7
digits for: B

0001 < number < 100 41.428571428571431

Otherwise display format
long e.

format short e | Scientific notation with 4 >> 290/7

decimal digits. e
4.1429e+001

format longe Scientific notation with 15 [>> 290/7
decimal digits. ans =

4.142857142857143e+001

format short g |Best of 5-digit fixed or >> 290/7
floating point. o
41.429
format longg Best of 15-digit fixed or >> 290/7
floating point. e

41.4285714285714

format bank Two decimal digits. >> 290/7
ans =

41.43

format compact |Eliminates empty lines to allow more lines with
information displayed on the screen.

format loose Adds empty lines (opposite of compact).

1.5 ELEMENTARY MATH BUILT-IN FUNCTIONS

In addition to basic arithmetic operations, expressions in MATLAB can include
functions. MATLAB has a very large library of built-in functions. A function has
a name and an argument in parentheses. For example, the function that calculates
the square root of a number 1s sgrt (x). Its name 1s sgrt, and the argument 1s
x. When the function 1s used, the argument can be a number, a variable that has
been assigned a numerical value (explained in Section 1.6), or a computable
expression that can be made up of numbers and/or vanables. Functions can also
be included in arguments, as well as in expressions. Tutonal 1-2 shows examples



Tutorial 1-1: Using MATLAB as a calculator.

>> T7+8/2 - [ Type and press Enter. ]
ans = : -

11 [ 8/2 1s executed first. J
>> (7+8) /2 - Type and press Enter. |
et | 7+8 is executed first. |

7.5000
>> 4+5/3+2
ans = | 5/3 is executed first. |

7.6667
>> §5+~3/2
ans = { 573 1s executed first, /2 1s executed next. ‘

62.5000
>> 27~(1/3)+32"~0.2 :
1/3 1s executed first, 277(1/3) and 3270.2 are
ansgs = ;
5 executed next, and + 1s executed last.

>> 2771/3+32%0.2 27”1 and 3270.2 are executed first, /3 is EKE-]

cuted next, and + 1s executed last.

ans =
alia -

>> 0.7854-(0.7854) 73/ (1*2*3)+0.785"5/ (1*2*3*%4*5) ,
-(0.785)*7/ (1*2*3%4*5%6*7)

Type three periods ... (and press Enter) to

e continue the expression on the next line.

0.7071

>> The last expression 1s the first fn:}ur}

terms of the Taylor series for sin(n/4).

1.4 DISPLAY FORMATS

The user can control the format in which MATLAB displays output on the screen.
In Tutorial 1-1, the output format 1s fixed-point with four decimal digits (called
short), which 1s the default format for numerical values. The format can be
changed with the format command. Once the format command 1s entered, all
the output that follows 1s displayed 1n the specified format. Several of the avail-
able formats are listed and described in Table 1-2.

MATLARB has several other formats for displaying numbers. Details of these
formats can be obtained by typing help format in the Command Window. The
format in which numbers are displayed does not affect how MATLAB computes
and saves numbers.



tions are:

Operation Symbol Example
Addition + 5+3
Subtraction - 5-3
Multiplication "' 5%3

Right division / 5/3

Left division \ 5\3=3/5
Exponentiation "‘ 5 3 (means 5° = 125)

It should be pointed out here that all the symbols except the left division ar
the same as in most calculators. For scalars, the left division is the inverse of th
right division. The left division, however, 1s mostly used for operations wit
arrays, which are discussed in Chapter 3.

1.3.1 Order of Precedence

MATLAB executes the calculations according to the order of precedence dis
played below. This order is the same as used in most calculators.

Precedence  Mathematical Operation

First Parentheses. For nested parentheses, the innermost
are executed first.

Second Exponentiation.
Third Multplication, division (equal precedence).
Fourth Addition and subtraction.

In an expression that has several operations, higher-precedence operations ar
executed before lower-precedence operations. If two or more operations have th
same precedence, the expression 1s executed from left to right. As illustrated in th
next section, parentheses can be used to change the order of calculations.

1.3.2 Using MATLAB as a Calculator

The simplest way to use MATLAB 1s as a calculator. This 1s done in the Com
mand Window by typing a mathematical expression and pressing the Enter ke
MATLAB calculates the expression and responds by displaying ans = and th
numerical result of the expression in the next line. This 1s demonstrated in Tutori:
I-1.



The semicolon ( ; ):

When a command 1s typed in the Command Window and the Enter key 1s
pressed, the command 1s executed. Any output that the command generates 1s dis-
played in the Command Window. If a semicolon ( ; ) 1s typed at the end of a com-
mand the output of the command 1s not displayed. Typing a semicolon 1s useful
when the result 1s obvious or known, or when the output 1s very large.

If several commands are typed in the same line, the output from any of the
commands will not be displayed 1f a semicolon 1s typed between the commands
instead of a comma.

Typing %:

When the symbol % (percent) is typed at the beginning of a line, the line 1s desig-
nated as a comment. This means that when the Enter key 1s pressed the line 1s not
executed. The % character followed by text (comment) can also be typed after a
command (in the same line). This has no effect on the execution of the command.

Usually there 1s no need for comments in the Command Window. Comments,
however, are frequently used in a program to add descriptions or to explain the
program (see Chapters 4 and 6).

The clc command:

The clc command (type clc and press Enter) clears the Command Window.
After working in the Command Window for a while, the display may become very
long. Once the clc command 1s executed a clear window 1s displayed. The com-
mand does not change anything that was done before. For example, if some vari-
ables were defined previously (see Section 1.6), they still exist and can be used.
The up-arrow key can also be used to recall commands that were typed before.

The Command History Window:

The Command History Window lists the commands that have been entered in the
Command Window. This includes commands from previous sessions. A com-
mand in the Command History Window can be used again in the Command Win-
dow. By double-clicking on the command, the command is reentered in the
Command Window and executed. It 1s also possible to drag the command to the
Command Window, make changes 1f needed, and then execute it. The list in the
Command History Window can be cleared by selecting the lines to be deleted and
then selecting Delete Selection from the Edit menu (or right-click the mouse
when the lines are selected and then choose Delete Selection in the menu that
opens).

1.3 ARITHMETIC OPERATIONS WITH SCALARS

In this chapter we discuss only arithmetic operations with scalars, which are num-
bers. As will be explained later in the chapter, numbers can be used in arithmetic
calculations directly (as with a calculator) or they can be assigned to variables,
which can subsequently be used in calculations. The symbols of arithmetic opera-



1.2 WORKING IN THE COMMAND WINDOW

The Command Window 1s MATLAB’s main window and can be used for execut-
ing commands, opening other windows, running programs written by the user, and
managing the software. An example of the Command Window, with several sim-
ple commands that will be explained later in this chapter, 1s shown in Figure 1-5.
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>> b=3;
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To type a command the cursor 1s placed
next to the command prompt ( >> ).

Figure 1-5: The Command Window.

Notes for working in the Command Window:

* To type a command the cursor must be placed next to the command prompt ( =>>).

* Once a command 1s typed and the Enter key 1s pressed, the command is executed.
However, only the last command 1s executed. Everything executed previously
(that might be still displayed) 1s unchanged.

» Several commands can be typed in the same line. This is done by typing a comma
between the commands. When the Enter key 1s pressed the commands are exe-
cuted in order from left to right.

[t is not possible to go back to a previous line that is displayed in the Command
Window, make a correction, and then re-execute the command.

* A previously typed command can be recalled to the command prompt with the up-
arrow key ( 4 ). When the command is displayed at the command prompt, it can

be modified if needed and then executed. The down-arrow key ( ¢ ) can be used to
move down the list of previously typed commands.

* Ifa command 1s too long to fit in one line, 1t can be continued to the next line by
typing three periods ... (called an ellipsis) and pressing the Enter key. The con-
tinuation of the command 1s then typed in the new line. The command can con-
tinue line after line up to a total of 4,096 characters.
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Figure 1-4: The Help Window.

When MATLARB is started for the first time the screen looks like that shown in
Figure 1-1. For most beginners it 1s probably more convenient to close all the win-
dows except the Command Window. (Each of the windows can be closed by
clicking on the x button.) The closed windows can be reopened by selecting

them from the Desktop menu. The windows shown in Figure 1-1 can be displayed
by selecting first Desktop Layout in the Desktop menu and then Default from
the submenu. The various windows in Figure 1-1 are docked to the desktop. A
window can be undocked (become a separate, independent window) by clicking

on the # button on the upper right-hand corner. An independent window can be
redocked by clicking on the ~|button.
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Figure 1-2: Example of a Figure Window.

Editor Window: The Editor Window 1s used for writing and editing programs.
This window 1s opened from the File menu. An example of an Editor Window 1s
shown 1n Figure 1-3. More details on the Editor Window are given in Section
1.8.2, where 1t 1s used for writing script files, and in Chapter 7, where 1t 1s used to
write function files.
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% Example of a script file.

% This program calculates the roots of a guadratic eguation:
R A*"X"d + DX + o= (Q

§ = amq; bw=9; cw=17,5;

g - DIS=sqrec (b*2=-4%a*g);
T - X1l= (=-b+DIS)/ (2*a) -
B - X2= (-b=DIS)/ (2*a) —

Figure 1-3: Example of an Editor Window.

Help Window: The Help Window contains help information. This window can
be opened from the Help menu in the toolbar of any MATLAB window. The Help
Window 1s interactive and can be used to obtain information on any feature of
MATLAB. Figure 1-4 shows an open Help Window.



selecting Command Window Only from the submenu that opens. Working in the
Command Window is described in detail in Section 1.2,
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Figure 1-1: The default view of MATLAB desktop.

Table 1-1: MATLAB windows

Window Purpose

Command Window Main window, enters varables, runs
programs.

Figure Window Contains  output from  graphic
commands.

Editor Window Creates and debugs script and

function files.

Help Window Provides help information.

Command History Window | Logs commands entered 1n the
Command Window.

Workspace Window Provides information about the
variables that are used.

Current Folder Window Shows the files in the current folder.

Figure Window: The Figure Window opens automatically when graphics com-
mands are executed, and contains graphs created by these commands. An example
of a Figure Window 1s shown 1n Figure 1-2. A more detailed description of this
window 1s given in Chapter 5.



